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Welcome to the latest edition of my monthly Final Cut Studio newsletter for June, 2007.

The goal of this newsletter is to provide information helpful to the professional user of Final 
Cut Pro. This newsletter publishes each month. Past issues are not archived. However, key 
articles are posted on my website for your reference. All software references are to Final Cut 
Studio unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We now have over 150 
tutorials to help you get the most out of Final Cut!
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Welcome

Thanks for joining us this month! There's a lot going on -- Final Cut Studio 2 has shipped, Apple's World-
wide Developer Conference is under way, and the Mighty Ducks just won the Stanley Cup. I mean, how 
weird is that?

Anyway, lest we get caught up in the cosmic significance of it all, let's get started with the question 
everyone seems to be asking...
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When Should You Upgrade to Final Cut Studio 2?

I've been using FCS 2 for about a week and a half. As well, I've been talking with the team of Final Cut 
gurus that write for Edit Well. Finally, I've been keeping my eye on my email and the various forums out 
there. Based on all these sources, here are my recommendations:

●     Final Cut Pro 6 -- probably one of the most solid releases in its history. Definitely worth upgrading 
and using.

●     DVD Studio Pro 4 -- no changes since previous version. Solid and dependable.
●     Compressor 3 -- significant interface improvements with reasonable performance. Key features 

include: job chaining, better batch templates, and improved optical flow for speed and frame size 
changes.

●     LiveType 2 -- no significant changes. Solid. Motion is sexier, but LiveType does a great job when 
you just need to animate text.



●     Color -- a solid release, but it's interface will take a lot of getting used to. It also demands the 
absolute most from your system. Check Apple's system requirements VERY carefully before using 
this application. (The June issue of Edit Well has two excellent articles by Alexis Van Hurkman on 
what you need to know to use Color. These are MUST reads for anyone serious about using Color. 
The issue will be out the last week of June.)

●     Soundtrack Pro 2 -- I like what Apple has done, but the application isn't stable. Wait for a dot 
release before relying on it for serious work.

●     Motion 3 -- The new tools in Motion are amazing, but the stability is not yet there. Like Soundtrack, 
use it for experimenting, but wait for a dot release before relying on it for tight deadlines.

All-in-all, Final Cut Studio 2 is a huge step forward. I'm looking forward to learning, using, and teaching it 
over the next several months.

Keep in mind the two golden rules: 

●     NEVER upgrade in the middle of a project. 
●     NEVER upgrade when facing a deadline — give yourself time to learn what's new in the program. 
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FCP Rescue Has Been Updated for FCP 6

Anders Holck has been hard at work updating the premier Final Cut Pro preference manager to support 
FCP 6. It is now available and still free.

You can download it here: http://fcprescue.andersholck.com.

Thanks, Anders!
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Thoughts on an Interface

At NAB this last April, I had the pleasure of interviewing Richard Townhill, Apple's Director of Product 
Management for the ProAps. (If you haven't heard that audio interview, we published 45 minutes of it in the 
April issue of Edit Well.) He made many excellent points and, during our interview, he spoke extensively 
about all the products in Final Cut Studio 2, including the upcoming Final Cut Server.

One of his answers, though, has been echoing in my head ever since.

At one point, I asked him why Final Cut's interface had not been updated with Final Cut Pro 6. Richard 
replied: "You change the Final Cut Pro interface at your peril. Final Cut became successful because of its 
interface and you don't want to do anything that will damage it."

I had not considered the issue from his perspective before and I realize, now, why Apple is reluctant to 

http://www.larryjordan.biz/nxltrs/www.peachpit.com/editwell
http://fcprescue.andersholck.com/
http://www.peachpit.com/promotions/promotion.asp?promo=4036&rl=1
http://www.apple.com/finalcutserver/


make any major changes to the interface for fear of scaring off current or future users. If I were in his 
position, I would probably think the same thing.

However, I'm not. I use Final Cut every day to get work done. And there are many things about the Final 
Cut interface that just drive me nuts. Plus, I suspect, there are a few things you'd like to see changed, as 
well.

For instance, here's my top ten list of things that need to be changed:

1.  Markers should be selectable and draggable both up and down the Timeline
2.  Bezier control points should NOT be essentially the same size and color as motion path dots
3.  If you can jump the playhead to a clip, you should be able to jump a clip to the playhead. 
4.  Buttons that change color should not go from a medium gray to a medium dark gray, or a medium 

dark gray to a medium dark green. They don't need to use radioactive orange, but I would like 
something a bit more, um, visible.

5.  Text in any dialog, such as Reconnect Media, should be readable sitting two feet away from a 23-
inch Cinema Display.

6.  There should be an easier way to see if a filter or effect is applied to a clip without turning on 
Timeline keyframe editing and making all your tracks excessively tall.

7.  Keyframes should be selectable individually or in groups
8.  Either calculate the file name, as in the Log & Capture window, or don't calculate the file name, as 

in the Log & Transfer window. Pick one.
9.  Allow label colors to be changed.

10.  Allow tracks to be named.

I'm sure you have your pet peeves as well. So, here's the deal -- I'm sponsoring a contest with absolutely 
NO prizes of any sort - simply the warm glow that comes from doing a good deed for humanity.

I'm asking you to send me your Top 10 list of interface changes that you'd like to see in the next version 
of Final Cut. Here are the rules:

1.  An interface change is something involving color, position, size, or shape of an existing Final Cut 
Pro element, screen, dialog or feature.

2.  An interface change is NOT having Final Cut do something new, but how an existing feature looks 
or works.

3.  Email your ideas to me using Interface Thoughts as the subject (anything else will automatically end 
up in my Junk Mail folder). 

4.  I'll summarize everyone's opinions and send them to the ProAps team at Apple as well as publish 
them in my next newsletter or website.

5.  Remember, NO feature requests.
6.  Please limit your list to 10 items
7.  Write clearly and pleasantly -- remember, we want to impress Apple with our passion, not bludgeon 

them with it.

Final Cut is a great application - but there's no reason for odd interface quirks to linger just because we are 
afraid of change.

Oh, and did I mention -- NO feature requests? Good.

Send me your comments and let's see what happens.

mailto:larry@larryjordan.biz?subject=Interface Thoughts
mailto:larry@larryjordan.biz?subject=Interface Thoughts


Legal stuff

●     There's no money in this.
●     I have no control over Apple.
●     Apple may not listen.
●     None of your suggestions are guaranteed to be implemented.
●     Your suggestions may be published on my website or in next month's newsletter.
●     What better use can you make of your spare time, send in your ideas now!

Mike Horton did something like this once and it took him weeks to recover. In case I get buried, I'll get this 
sorted as quickly as possible.
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PowerUP Seminars Start in Santa Barbara

I'm starting my next PowerUP with Final Cut Studio Seminar Tour June 25 & 26 in Santa Barbara. 
These two days feature three different seminars:

●     Picking the Right Hardware
●     Optimizing Your Final Cut System
●     Mastering Final Cut Studio

I'm also delighted to announce that SmartSound and Automatic Duck are joining us as sponsors for our 
tour! Thanks to sponsors like these, we can visit more cities, provide more seminars, and keep our costs 
down. 

If you are new to Final Cut, you should plan to attend Picking the Right Hardware and Optimize your 
Editing. Hardware walks you through what you need to know to select the right computers, hard disks, 
monitors, and other gear you need to successfully edit with Final Cut Studio. We will have a special section 
on Color, as it's system requirements are especially stringent. Here's the current agenda. 

Optimize your Editing covers the software portion of your system: trouble-shooting, optimizing, file 
organization, moving files between applications, speeding up editing and trimming, and making the most of 
Final Cut Pro. Here's the current agenda. 

Mastering Final Cut Studio gives you the inside tips on working with Motion, Soundtrack Pro, Color and 
Compressor. Covering each of these applications takes far more than a few hours, rather we help you get 
past your fear and show you how to become productive so you can explore them further on your own. 
Here's the current agenda. 

http://www.larryjordan.biz/sem/2007_sb.html
http://www.larryjordan.biz/sem/2007_fall.html
http://www.larryjordan.biz/sem/2007_sb.html
http://www.larryjordan.biz/sem/2007_sb.html
http://www.smartsound.com/
http://www.automaticduck.com/
http://www.larryjordan.biz/sem/2007_fall_agendas.html#hardware
http://www.larryjordan.biz/sem/2007_fall_agendas.html#optimize
http://www.larryjordan.biz/sem/2007_fall_agendas.html#mastering


Santa Barbara in June is our pre-launch -- I invite you to join us if you want to get a head start on all the 
new software. Attendees will get a detailed first look at the software, and help us decide what goes into Fall 
Tour because our "official" tour doesn't start until August. 

Click here for pricing, details and registration -- www.larryjordan.biz/seminars.

If you need reassurance that you are not wasting your time or money, click here to read what other editors 
have said.
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Review: Matrox MXO

Wayne Andrews, the RT & MXO product manager for Matrox Video Products Group, saw me at the NAB 
SuperMeet and demanded that I take a look at what Matrox was doing.

Well, I will confess that Matrox has not been on my radar since RT-Mac did not make the transition from 
OS 9 to OS X. And, I had a number of client that had problems with the RT-Mac. Still, Wayne was insistent, 
and we were in the same room, so I headed over to take a look.

The Matrox MXO is a small silver box about the size of a paperback book that connects to the DVI monitor 
output on your computer. You then attach a second computer monitor which allows you to use the MXO for 
monitoring. While the MXO does not assist with capturing or digitizing, it solves two crucial problems faced 

http://www.larryjordan.biz/sem/2007_sb.html
http://www.larryjordan.biz/sem/2007_fall.html
http://www.larryjordan.biz/training/testimonials.html


by editors working with HD media: How do you monitor it and how do you output it?

I've been working with capture cards and devices from AJA and Blackmagic Design for a while now. But 
what the Matrox MXO does that's so important is:

●     It uses your DVI connector, which means it can work on either a laptop or tower system
●     It displays your video to a second computer monitor, which is far less expensive than an HD video 

monitor.
●     It displays interlaced video to this second monitor
●     It displays the video using video color space (Y'CrCb), rather than the RGB color space used by 

computers.
●     It can output either HD-SDI or HD-analog or, in real-time, downconvert to SD video in either analog 

or SDI format.
●     It supports any DVI monitor that your Mac supports
●     Best of all, to me, is that the monitor can be calibrated. This means that you can adjust the monitor 

to improve its accuracy.

One of the challenges in working with HD media is that many formats are interlaced. However, Final Cut 
Pro doesn't display interlacing unless you set your Canvas or Viewer to display images at 100%. However, 
this is not practical for editing in HD.

One of the concerns I've heard expressed about Apple's 23-inch Cinema Display is that it does a 
particularly poor job displaying black levels properly. I noticed this as well as I was calibrating the monitor 
because during the calibration, the black levels became unreasonably dark.

I asked Wayne Andrews about this and he wrote: "With the MXO, super whites and super blacks are now 
visible on a DVI monitor which overcomes this exact issue. We promote the Apple Cinema Display 
because of its popularity."

He continues, "The MXO supports all QuickTime-based applications that support the V-out component, i.e. 
After Effects, Soundtrack Pro and Motion. When the app has the ability to select a “Video Out”, the MXO is 
in the mode we refer to as “Mastering Mode;” mastering to tape, if you will. It’s this mode that really rocks!. 
The MXO actually takes the YUV (Yp Pb Pr) data before the graphic card has a chance to convert it into 
RGB, so there is no YUV/RGB/YUV conversion done providing the editor a true video signal out of the 
MXO for printing to tape or broadcasting for example.

"For applications that do not support the QuickTime V-out component, i.e. Photoshop, DVD Studio pro, 
Livetype, the MXO can still be used to check for “title placement”, “DVD simulation” before burning, and 

http://www.aja.com/
http://www.blackmagic-design.com/


even “ringing” within a graphic are examples. This mode we refer to as “Presentation mode”, that is, we are 
running it as an HD/SD Genlock-able scan converter." 

(Larry again.) By the way, while a 20" monitor would be fine for 720p HD video, it is too small for 1080i. 
The Cinema Display is the smaller monitor that will allow you to see every pixel in your image. However, 
the MXO offers "Scale to fit" option in its control panel, The MXO will take any resolution, 1080 for 
example, and scale it to fit the 20" monitor native resolution something like 1650x1200. You won't see 
every pixel in the larger image, but if you don't work with 1080i very often, this is a good workaround. 
However, leave "Scale to Fit" off, in general, to avoid blowing up SD or 720p media when displayed on a 
larger monitor.

I found installation and setup surprisingly difficult. A "Read Me First" manual would be really helpful. Also, 
the correct drivers were not included in the box (all these new features require version 2 which started 
shipping in May). Second, it took me two days to find the User Manual. The manual was only available on-
line and Matrox requires that you to register as a user before you can download the manual. This is an 
unnecessarily awkward step, in my opinion. (Wayne tells me that after I spoke with them about this, they 
have made all their manuals available on their website without requiring registration.)

Properly calibrating the monitor can also be tricky, however, the good news is that the MXO provides all 
the necessary tools to calibrate the monitor - it just takes a while.

Another problem is that the MXO provides so many different monitoring options, it is very, very difficult to 
pick the right one from the dozens available. Matrox should look to make this selection process easier -- 
either by limiting the number of different options during installation, or by finding a way to simplify the 
selection dialog (View > Video Playback).

Once I got everything working, using it was easy. I enjoyed the simplicity of pressing the space bar and 
watching my HD footage on a second monitor. I especially liked using it to verify interlace problems that my 
computer monitor did not show. And it's ability to quickly downconvert HD footage into any SD format is a 
real plus! 

One thing I didn't do was to test it on a variety of monitors. As I did my testing at an Apple Dealer, the only 
monitors we had to select from were Apple.

If you are looking for better ways to monitor your HD footage, and you can't afford HD monitors that range 
in price from $4,000 to $24,000, the Matrox MXO should definitely be considered. There is no reason to 
use the MXO if you are working in SD, as a good SD monitor costs less than the MXO.

The MXO has a suggested retail price of $995. It runs on both laptops and towers, and provides real-time 
video monitoring and HD-to-SD down-conversion. These are all excellent things. 

Find out more by visiting their website.
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Southern Louisiana Has a New Final Cut User Group

http://www.aja.com writes:

http://www.matrox.com/video/products/mxo/home.cfm


We've started a new Final Cut Pro User Group for Southern Louisiana and have met all 
Apple's conditions to be certified.

I'd be grateful if you could mention this to your readers. They can learn more about us at: 
http://www.slfcpug.org

Larry replies: Thanks, and best wishes for continued growth!
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Quick Web 2.0 Application Survey

The last time we did a survey, in January, the results were so fascinating that we 
developed our "Grow Your Business" webinar and CD from the results. 

Well, we are working on some new ideas and we need your feedback again. This time, 
on whether you are using any Web 2.0 applications.

Social networking and video communication are exploding in entirely new ways and 
we are trying to figure out if this is simply using existing tools in new ways, or if we 
need to adjust our training to help editors understand this new environment.

That's where we need your help. 

Please take a second and answer our one question survey on what Web 2.0 
applications you are using. Even if you DON'T use them - that helps us, too.

Responses are ALWAYS confidential and we'll let you know the results next month.
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Growing Your Business CD

http://www.slfcpug.org/
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=49&osCsid=50e082c409b7ddd1c28a6044d02752d0


Thinking of surveys, last month, we presented a series of web seminars (webinars) on Growing Your 
Business, which was based on a survey we took in January. These webinars were very successful -- in 
fact, two of the three sold out.

We got lots and lots of comments, compliments and suggestions on ways to make this better and more 
focused on editors; all of which we implemented during the course of our seminars during May.

However, we also realized that this information could just as easily be presented via QuickTime movies on 
a CD, where you could view them at your convenience, plus, with a CD, we could include all the 
PowerPoint slides, so you don't need to take as many notes.

So, I'm pleased to introduce: Growing Your Business -- on CD! We took all your feedback, re-did all the 
content, recorded it as a series of illustrated QuickTime movies, and put it onto one CD. 

Everyone who participated in our webinars will get a FREE copy. For everyone else, you can get dozens 
and dozens of tips you can use today to grow your business for the ridiculously low price of $39.90.

Click here to learn more -- then order your copy today!

And, thinking about our store reminds me - we have a new store! Our new store is designed to better 
accommodate the needs of our customers and to improve the overall shopping experience.

Here are some of the features we've added:

●     Products Reviews - You can now share your opinions on our products with other customers, and 
read what others have to say.

●     Permanent Shopping Cart - Any products you add to your online cart remain there, even between 
visits, until you remove them, or purchase them.

●     Address Book - We can now deliver your products to an address other than yours! And, you are 
able to save multiple addresses to your Address Book for future use.

●     My Account - You can now view your purchase history and track the status of your orders.
●     Product Notifications - You can now request email notifications informing you of product changes or 

updates.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=49&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=49&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/store/index.html


It's taken us about three months to make the upgrade and I'm very excited about all the possibilities. I'd 
also like to thank our webmaster, Srithip, for all her hard work. Take a few minutes to explore and let me 
know what you think: www.larryjordan.biz/store.

By the way, we've added the excellent laminated keyboard shortcut guides from Loren Miller covering Final 
Cut Pro 5, DVD Studio Pro, Soundtrack Pro 1 and After Effects 6 . These place-mat-sized guides can save 
you a ton of time in discovering the secrets to speed in each of these applications.

Oh, and if you are wondering which products can best meet your needs, take a look at our Store Guide for 
some advice. 
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Why Video Bit Depth Matters

ProRes is the new QuickTime codec Apple released with Final Cut Studio 2. The reason it needed to be 
invented was that none of the HD codecs currently shipping with QuickTime supported both small file size 
and 10-bit quality. You could get one or the other, but not both.

The reason 10-bit quality is important is illustrated in this simulated picture.

All shades of gray, and shades of a color, are represented by a numeric value. In 8-bit video, these values 
range from 0 - 255. In 10-bit video, these values range from 0 - 65,536. In both cases, 0 represents the 
absence of something, either white or a color, while either 255 or 65536 represents the maximum amount 
of white, or a color.

Research has shown that an 8-bit gray scale is essentially sufficient to smoothly represent all the shades of 
gray our eye can perceive. However, 8-bit color shows banding, that is, clear divisions between different 
shades of color. I've simulated this in the lower portion of the illustration above. 

To prevent banding, color needs to be stored in 10-bit files. This provides smaller differences between 

http://www.larryjordan.biz/nxltrs/www.larryjordan.biz/store
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=45&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=45&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=47&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=46&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=48&osCsid=50e082c409b7ddd1c28a6044d02752d0
http://www.larryjordan.biz/store/assist.html


color values, which prevents banding, but at the expense of much larger files.

DV, DVCPRO-50, DVCPROHD, HDV, XDCAM -- the formats that many of us use every day -- are all 8-bit 
formats. This means that they will have a tendency to exhibit banding in saturated colors. 

This problem is made worse as we start using Color for color correction. This is because Color needs to 
render your color corrections into video files as part of its final output process. If you output 8-bit video, you 
could easily inject banding into your final masters.

To solve these problems, ProRes allows you to store both SD and HD video using 10-bit values, but at file 
sizes up to 33% smaller than uncompressed SD files and 90% smaller than uncompressed HD files. This 
allows us to take advantage of the improved image quality 10-bit video offers, without totally overloading 
our hard drives with massive files.

Here are some general rules you can use:

●     8-bit video files are smaller than 10-bit, however, color fidelity can suffer
●     8-bit files are perfectly OK for off-line and/or rough-cut uses
●     8-bit images are generally OK for images that don't have lots of color saturation or effects 
●     10-bit files are better for mastering
●     Using ProRes for mastering SD video will, probably, look better than native DV. Your file sizes, 

however, will increase to 65 GB per hour of video at a data rate of 18.125 MB/second.
●     Using ProRes for mastering HD video will, probably, look better than native HDV, DVCPROHD, 

XDCAM, and the same as HDCAM or HDCAM SR. Your file sizes will be up to 99 GB per hour, at a 
data rate of 27.5 MB/second. These files will be much bigger than similar HDV or XDCAM, bigger 
than DVCPROHD and much, much smaller than HDCAM and HDCAM SR. 

Note: Frame rate and image size will impact file size, these estimates assume worst case. Apple indicates 
under "normal conditions" we should expect file sizes about 30% smaller than my numbers.

As video editors we are constantly balancing image quality with file size. With ProRes, we have another 
tool we can use to help us in this process. While no one codec meets all possible needs, ProRes deserves 
to be seriously considered.
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Thoughts on the ProRes Codec

Chuck Spaulding has been involved in motion graphics and codecs for a number of years. Recently, he 
and I got into a discussion of video codecs and he provided his thoughts on Apple's ProRes codec.

Quality appears to be quite good, although I’m sure the folks at Cineform and SheerVideo 
will do a comprehensive evaluation and we’ll learn the RMS error rate, what its weaknesses 
are and how it holds up in post. However image quality is only half the equation, workflow is 
the other half and I’m having a tough time figuring out a workflow that makes sense.

After seven or eight generations of ProRes re-compression there is a noticeable difference 
compared to the uncompressed original which means that the codec isn't lossless, which 
would seem to be a minimal standard for an editing codec. If ProRes progressively degrades 



the image even when you haven't edited a single pixel, how can it possibly hold up under 
real-life situations where you're transforming, filtering, adding effects, compositing, color-
grading, and so on?

So ProRes is a lossy codec, it is 4:2:2 [not 4:4:4], it is Y'CbCr [not RGB], and it does not 
support alpha channels. Nowadays, almost all commercial productions combine video 
(Y'CbCr) footage with digitized film (Cineon) and CGI (RGB), so the ability to handle and 
transport data equally well is imperative, as is the ability to convert between them without 
loss. It's hard to imagine a video or film production without compositing, yet Apple's ProRes 
codec, like their uncompressed Y'CbCr 4:2:2 and AIC codecs, do not support an alpha 
channel.

The lack of an embedded alpha channel means that compositing requires two streams of 
data for each overlay instead of just one, exacerbating the already painful bandwidth 
problems associated with high-definition video. Also, in SD, video professionals are 
accustomed to smeared chroma, there's a popular myth that sub-sampling chroma doesn't 
matter because the human eye doesn’t resolve chrominance as well as luminance. In the 
human retina as a whole, it's true that color-blind rods outnumber hue-discriminating cones. 
In the fovea, however, which receives the part of the image we pay attention to, the retina 
has no rods at all - only cones. So while 4:2:2 may look good enough for standard definition 
video it is not good enough for anything beyond SD.

That doesn’t mean that it isn’t a step in the right direction and I’m sure FCP users will adopt 
it. However one real problem with this codec is that it is Apple-only, meaning it won’t work 
with Premiere on the Mac Pro. This is a significant constraint of the workflow.

Larry replies: Thanks, Chuck. If anyone has additional comments, please send them and I'll update this 
article.
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Any Requests for Final Cut Pro 6 Training?

I'm back in the recording studio later this month for Lynda.com. We are redoing all our existing Final Cut 
Pro 5 training to update it for Final Cut Pro 6.

(By the way, I just finished a quick overview of the new features in Final Cut Pro 6 for them - it should be 
released by the time you read this.)

Anyway, since I have to re-record everything anyway, I wanted to ask if there is anything special you'd like 
to learn. We are creating two titles: one for editing and a second for effects. 

Here's the Table of Contents for our current FCP 5 Editing title.

Here's the Table of Contents for our current FCP 5 Effects title.

Send me an email with your requests and I'll see what I can do to include it. Thanks!

http://www.larryjordan.biz/goodies/FCP5_TOC_Edit.pdf
http://www.larryjordan.biz/goodies/FCP5_TOC_EFX.pdf
mailto:larry@larryjordan.biz?subject=Training Ideas
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Thought for the Day #1

Dan Olderman sends in the following quote from Albert Einstein:

"If a cluttered desk is the sign of a cluttered mind, of what, then, is an empty desk?"

[ Go to Top. ] 

This Month in Edit Well

Edit Well-- the rich-media newsletter for Final Cut Studio, which I edit and Peachpit Press publishes, has 
the latest news on Final Cut Studio 2.

The May issue has the first published "First Looks" of:

●     Color
●     Soundtrack Pro 2

Plus, we also have articles on:

●     Using Final Cut Pro patch panel
●     Exporting still images and removing interlacing
●     Creating animated backgrounds in Motion

On top of all THAT, we added:

●     Audio highlights from the NAB SuperMeet
●     Audio profile Bam Ross, about a business model for podcasting
●     Video tutorial on creating a traveling matte

Edit Well contains the techniques and tips that you just can't find anywhere else. In Edit Well, you don't just 
read about it.. you also watch and listen to it. And, at only $59 per year, this is a GREAT deal!

Click here to view May's Table of Contents. Click here to subscribe: www.peachpit.com/editwell.

And coming up in June are four killer articles on Soundtrack Pro 2, Color and Final Cut Pro that you don't 
want to miss.

http://www.larryjordan.biz/nxltrs/www.peachpit.com/editwell
http://www.larryjordan.biz/assets/editwell/ew12_TOC.pdf
http://www.peachpit.com/editwell


Edit Well is the perfect compliment to this newsletter -- if you like my newsletter, you'll love Edit Well. (If 
you have any problems subscribing, send me an email.)

[ Go to Top. ] 

A Matter of Handles

Brian Pshyk, from Calgary, writes:

Every so often when I try to apply a cross dissolve between 2 clips (one a video clip and the 
other is a motion created piece) the transition defaults to a 1 frame transition and I cannot 
increase its length. The effect stays on the timeline as 1 frame in duration. Is this a known 
bug?

Larry replies: Nope. It's a lack of handles.

Handles are extra video before the In and after the Out. They are only relevant for Timeline clips. When 
you apply a transition, say a 30-frame dissolve, between two clips in the Timeline, during the course of that 
dissolve, Final Cut displays video from both the out-going and the in-coming clips. Both are on screen at 
the same time.

In this illustration, the gray area represents the extra video, or handles, after the Out of the top clip and 
before the In of the bottom clip. The X illustrates where both images are on screen at the same time during 
the dissolve. The calculation for a handle is that it needs to be 1/2 the length of your transition. Thus, a 30-
frame dissolve requires 15-frames handles on each clip. 

mailto:larry@larryjordan.biz?subject=Edit Well Problems


However, if one of your clips doesn't have any handles, as illustrated here where the bottom clip has no 
extra video before the In, the dissolve doesn't have enough extra video for both clips to appear at the same 
time during the dissolve.

So, Final Cut sets the duration of the dissolve to the longest amount of time that video from the two clips 
overlap -- in other words, one frame. 

The easiest way to see the handles for a clip is to double-click it to load it into the Viewer and look at the 
how much video there is before the In and after the Out.

Note: Final Cut allows you to alter the start point of your transition so that it can:

●     Start on the edit point (insufficient handles before the In)
●     Center on the edit point (sufficient handles on both clips) 
●     End on the edit point (insufficient handles after the Out)

You can make these timing adjustments either by dragging the transition icon around the edit point, or by 
double-clicking the transition icon to load it into the Transition Editor and adjusting it by clicking one of the 
three triangles at the top. 



[ Go to Top. ] 

Doing Stills the Hard Way

Mike Johnson writes:

Some of my students wanted to shoot stop motion then edit in FCP. So they used a digital 
stills camera and shot their film - at 3648 x 2736 which meant that each frame was 2.7 MB! I 
searched the web for ways of doing stop motion with FCP and couldn't find much of use. So 
we struck on our own formula for getting the stills into FCP since bringing them in directly as 
stills didn't work.

We opened the jpegs as an image sequence in QuickTime with a frame rate of 6 fps. The 
image was too big for the screen and the movie wouldn't play. But the stills were all there. 
So we exported it as a movie using photo JPEG as the compression type, setting the frame 
rate etc. On the size settings we used 912 x 684 (3648 x 2736 divided by 4) . This produced 
a playable movie. Then in FCP we set the sequence settings to 912 x 684 custom (4:3) 
square pixel, with a PAL time-base and the audio as DV defaults. Phew! It works. The movie 
fitted the timeline 100% and there was loads of definition to crop, zoom, pan and scan the 
frame. Is there an easier way for the next time!

Larry replies: Wow! That's doing it the hard way.

First, we need to clear up how you are using your stills. Are you using them as scans of images, where 
doing pan-and-scan is important or as individual frames of a movie, such as clay-mation?

In either case you need to compensate for the different pixel aspect ratios between the computer (square) 
and video (rectangular). 

●     A good image size for pan-and-scan in 4:3 NTSC is 1800 x 1350 x 72.
●     A good image size for pan-and-scan in 4:3 PAL is 1920 x 1440 x 72.
●     A good image size for full screen 4:3 NTSC is 720 x 540 x 72.
●     A good image size for full screen 4:3 PAL is 768 x 576 x 72.

Here's an article that describes the differences between video and computer images in more detail, 
including a complete list of various image sizes for different aspect ratios.

If you want to bring individual frames into Final Cut, go to Final Cut Pro > User Preferences > Editing 
tab...

http://www.larryjordan.biz/articles/lj_grfx_look.html


and set the Still/Freeze Duration to 00:00:00:01. This sets the duration of all imported still images to one 
frame.

However, an even easier way to do this is to use QuickTime Pro. 

Put all your still images in one folder and number them in the order you want them to play back. Then, 
select File > Open Image Sequence...

QuickTime will import all your images in order and allow you to export them as a single QuickTime movie. 
You can them import this movie into Final Cut and edit it as you would any other video file. 

For highest quality inside Final Cut, set Final Cut Pro > Easy Setup to Uncompressed 10-bit (either 
NTSC or PAL). The file sizes will be huge, but the quality will be as good as it gets.

Your resulting files can then be output to video tape, or compressed for a DVD for final distribution and 
playback.

[ Go to Top. ] 

Suggestions on Printing to Video

Don Breinlinger, from IDS Interactive, writes:

In last month's newsletter you spoke about reference, vs. self-contained movies. We export 
a self-contained movie and the use it to print to video, to output a 30 min. DV NTSC show. 
It's our understanding that it's easier for FCP to print one track of video and two of audio 
from a self-contained movie, than to print the finished sequence, which might have upwards 
of 20 tracks. 

My question is, is print to video using a reference movie any different than just printing from 
the timeline? I'd love to skip exporting a self-contained movie, but not at the risk of FCP 
dropping frames when outputting.

Larry replies: The short answer is: "No."



First, a quick definition. When you select File > Export > QuickTime Movie, at the bottom of the dialog 
box is a checkbox.

When Make Movie Self-Contained is checked, you are creating a QuickTime movie that contains all your 
video, all your render files, and all your audio complete and fully mixed in one gigantic file.

When Make Movie Self-Contained is not checked, you are creating a QuickTime move that contains all 
your audio, fully mixed, and pointers that point to where the video and render files are stored on your 
system.

The first type movie is called a "self-contained" QuickTime movie, the second is called a "reference" 
QuickTime movie. 

Reference movies are smaller and much faster to export, but they will only play on your system. In general, 
these are a good choice when you only need the video for a short period of time.

Now, to answer your question, whenever Final Cut gets ready to Print to Video, or Edit to Tape, it ALWAYS 
renders all tracks and effects so that when it plays back, FCP is ONLY playing one video track (either 
source video or render file) and two audio tracks (unless you've customized your audio output for multiple 
tracks.

In other words, there is no need to export anything, because Final Cut is automatically doing it for you. This 
is why earlier versions of Final Cut could play broadcast quality video in real-time on very slow computers 
(compared to today's models).

So, my recommendation is not to export anything, just print your sequence to video. If you are having 
output problems and your sequence just won't play, then follow these steps:

1.  Export your sequence as as self-contained QuickTime movie
2.  Create a new project
3.  Create a new sequence that matches the format of your exported movie



4.  Import your movie
5.  Select File > Print to Video.

In almost all cases, this will solve the problem.
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A Whole Bagful of John Gallagher Tips

John Gallagher is relocating his editing offices to Edinburgh, Scotland. During this last month, while 
waiting for the move, John decided he had too much time on his hands, so he sent in a whole batch of tips. 
Who am I to turn down such a wonderful gift?

Thanks, John!

What a Drag! - John Gallagher

Cheesy title, I know. Do you fancy dragging a window in Final Cut, but don't want to be bothered having to 
drag on the fiddly title bar to do it? Well, just on the off-chance that you "give a monkeys" as we Brits say, if 
you hold Command+Option, you can drag a window by dragging anywhere within it.

[ Go to Top. ] 

A Faster Way to Import Clips - John Gallagher

Do you need to import some files into Final Cut, but maybe, like me, you are trying to do too much at once 
and you've got Photoshop, Preview, Mail, Firefox and, of course, Final Cut all open at once. 

Well, select and drag the files from the Finder window you want and whilst you are holding down the 
mouse button, press Command+Tab repeatedly until Final Cut is highlighted, or move the cursor over the 
Final Cut icon. Let go of the Command key (whilst still holding the mouse button) and hey presto! You can 
now drag the files into the Browser. 



You could also drag the files straight into the sequence you're working on, but I think it's better to put them 
in the Browser first. This way you can see all the appropriate information about them and organize them 
with the other files.

What's t he advantage of this Command-Tab technique over File > Import > Files (Command+I)? Well, 
first, it's faster. However, the most compelling reason for me is that you can directly import the files into a 
specific bin, which, at least on 5.1.2, you cannot do just using the Import function. If you want to explore a 
bin that is closed, hold the files over the bin for a few seconds and in true "spring loaded folder" style, the 
bin will open.

This shortcut can be used with any application - it's system-wide. One last thing, I can't really see how this 
would be of use, but you can, should you wish, drag these files into the Viewer in FCP. If you have dragged 
more than one file, the Recent Items button allows you to see the others you have dragged.

[ Go to Top. ] 

Markers Update - John Gallagher

Last month I reported that you could create multiple overlapping markers. A bit more exploring and I have a 



couple of other tips on using markers.

First, you can select multiple markers in multiple clips by Command-clicking the markers you want to 
select. Then either Command-U or drag these markers to a bin (as per Larry's great tip) to convert them 
into subclips.

Second, you can load just the marked section of a clip by double clicking on the marker. This will open just 
the range the marker covers in the Viewer. However - beware. If you now try to add markers in this section 
of the clip, they disappear into something I've christened the "Marker Black Hole". Unless I'm missing 
something, FCP just deletes them as soon as you load any other clip into the viewer.

[ Go to Top. ] 

You need Q! - John Gallagher

I'm well aware that you can use Command-1, Command-2, and Command-3 to switch between Viewer, 
Canvas and Timeline respectively. This is all very well, but when I'm editing, I found myself hankering for 
something faster and easier to press. Thankfully, Final Cut didn't disappoint and after a quick peruse of the 
Tools > Button List (Option+J) I found my saviour - the Q key. 

Provided you're in the Viewer, Canvas or Timeline window, you can easily use this handy shortcut to 
navigate between windows and edit faster.

If you're in the Timeline window, press Q and you'll switch to the Viewer. Q again will switch to Canvas. 
From the Canvas you can perform most of the key commands you need to edit, the main exception being 
when you need to change the view in the Timeline. 

I love my Q key!
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Adjusting Cross Dissolves - John Gallagher



I'm sure this is old hat to any editor with the vaguest grasp of FCP, but it didn't occur to me until quite late 
in the day, so it's included here in the hope that it will help someone else. If you set up a Ken Burns effect (i.
e. a key-framed move) on a photo, then add in a cross dissolve to another photo, the Ken Burns effect will 
stop either before or in the middle of the dissolve. I used to have to fiddle around with the clip in the viewer 
before I realized that's what editing keyframes in the Timeline using Clip Keyframes is for.

Press Option-T and you should see motion keyframes in bars below your clips on the timeline. If not, you 
need to make sure it's switched on by right clicking on the Clip Keyframes button in the Timeline then going 
to Video > Motion Bar and making sure this is ticked.

You should see a Blue bar with diamonds for the points at which you've set the Keyframes. Drag these 
diamonds to the correct position at the end of the dissolve and you're done. If you have snapping on, they 
will even snap to the end, centre or start of the dissolve. Handy.

[ Go to Top. ] 

Spotlight Window - John Gallagher

This isn't strictly an FCP tip, but it can be handy to find files. If, like me, you don't really like the Command-
Space Spotlight interface, there is an alternative. 



Press Command-Option-Space and you'll get a proper window with extra options on how to sort or find 
files. There's also the Command+F Find command from the Finder which can be useful too.

John, thanks for all these great tips.

Reader Mail

Telling the Difference

Christopher Ridder writes:

I wanted to pass on a very simple way to always know if you are reading timecode in drop or 
non-drop mode inside or outside of FCP. Just look at the last time separator...

If the last time separator uses a colon the video is non-drop frame. If it uses a semicolon, the 
timecode is drop-frame. This distinction is only necessary for NTSC, PAL and HD always 
use non-drop-frame timecode.



Larry replies: Thanks. For those of us who have been in the industry for a while, we often forget that folks 
just starting can really use this tip.

- - -

Thought for the Day #2

Dan Olderman sends in the following quote from Albert Einstein:

"Only two things are infinite, the universe and human stupidity, and I'm not sure about the 
former."

Larry adds: Every time I read this, there are two past clients I think of immediately....
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"Best" Video Compression

Ken Cooper, from MultiVision in Tampa, writes:

We have more and more clients that want videos on the web that are 30 min.
to 1 hour long. I always try to get them to put up four 15 min. segments. Part 1, part 2 etc. 
Many of these are training videos they sell. We encode them into Flash with On2 Flix Pro. Is 
this the best way, or maybe you have some better ideas. I know our business is going to be 
doing so much more of this, I just want to make sure we are on top of what is really BEST.

Larry replies: "Best" is such a vague concept. Does it mean highest quality, smallest file size, fastest 
download, easiest to encode...? Because there's no one codec that meets all these competing demands. 

For great quality, H.264 is a wonderful codec, but the compression times are very long. Flash is also a 
good choice if you want to integrate your movie into a web page.

Based on your description, you are doing perfectly fine. 

[ Go to Top. ] 

Disposing of Old VHS Tapes

Gene Fozard writes:

I would venture a guess many of your readers have tons of old video tapes gathering dust, 
taking up space, attracting mold, and just begging to be disposed of.

I personally have boxes & boxes of UMatic, VHS, & SVHS tapes I'd like to dispose of in an 
environmentally friendly way. I do not at all feel comfortable doing the dumpster thing.



Do you have any suggestions?

Larry replies: I'm clueless -- however, if any reader has a suggestion, I'll be happy to pass it along.

[ Go to Top. ] 

Creating a PAL Image Sequence

Jacob Hodgman, of Corporate Communications, South Australian Police, writes:

Here's one that I'm not sure about.

The client wants to show a photo montage (Ken Burns-style), at a one-time-only exhibition, 
for which they have hired a 42 inch 1024 x 768 (PAL) television monitor.

Before I knew the resolution of the final display medium, I created the montage with all 
effects in standard 720 x 576 DV PAL with the plan of providing an SD DVD for use on the 
day. (This needs to be simple because they only want to use a DVD player and TV rather 
than a computer display.) While I can create a 1024x768 sequence in FCP, it's not 
supported once you get to DVDSP.

Since I can't create a 1024x768 DVD to match the monitor, what would be your approach?
It will never be broadcast. It needs to play on a stock standard DVD player.

As I'm only using photos, I'm not hassled by the fixed frame size of any video formats.
Quality over speed is my priority here.

Larry replies: I love puzzlers like this.

Since you are limited to a DVD player, you are also limited in your video options. SD PAL is your only 
choice - 720 x 576 for a 4:3 image.

However, since your monitor is 16:9, you can create your montage for this aspect ratio and it will look 
better. So, create your images at 1024 x 576, then import them into a DV PAL Anamorphic sequence.

If you were able to feed the screen with a computer, your options become much wider.

[ Go to Top. ] 

More on Deinterlacing Stills

Steve Lyons, of Lyons Den Video, wrote in with a comment on last month's article on deinterlacing (click 
here to read it):

http://www.larryjordan.biz/articles/lj_fields.html
http://www.larryjordan.biz/articles/lj_fields.html


In addition to what was mentioned in your monthly newsletter, when deinterlacing in 
Photoshop using interpolation, you can limit the area to be deinterlaced by selecting only the 
areas where there is noticeable movement to be deinterlaced. This results in a more detailed 
still.

Larry replies: Steve, you were the first of several people to suggest this. This is a great tip to retain as 
much image quality as possible. 

(By the way, shortly after my newsletter was published, Tom Wolsky wrote a detailed article on this for the 
May issue of Edit Well. It's still current, subscribe today and learn more ways to deinterlace.)
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Testing Multi-core CPUs

Greg Hydie, from Colorado, wrote:

I'm still skeptical about the multi-core support... it KILLS me to see 8 cores NOT working 
anywhere close to 100% when compressor is the only thing actively computing on the 
system. Even on my Quad... the results are bleak and tiresome.

Larry replies: Greg, that's one of the benefits we are looking forward to in Leopard (OS X 10.5). However, 
BareFeats did some additional benchmarks using the 8-core Macs and Final Cut Pro 6 that might reassure 
you that things are getting better: http://barefeats.com/octopro5.html
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Wrap-up

Well, that's it for another issue. Please take a few minutes and:

●     Purchase our Grow Your Business CD
●     Register to attend one of our PowerUP Seminars 
●     Subscribe to Edit Well

Your support for our seminars and products keeps our website, and this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share your ideas 
and suggestions, we all learn.

Until next month, take care, and edit well.

Larry

http://www.larryjordan.biz/nxltrs/www.peachpit.com/editwell
http://barefeats.com/octopro5.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=49&osCsid=f906342c24220faa0179de6edc29ef46
http://www.larryjordan.biz/nxltrs/www.larryjordan.biz/seminars
http://www.peachpit.com/editwell
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign up 
at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying these 
ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter has 
not been reviewed or sanctioned by Apple or any other third party. All trademarks are the 
property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter 
may not be reproduced or published in any way, in whole or in part, without specific written 
permission from the author. 
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